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CHAPTER 1 SPREADSHEETS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Spreadsheets have become a very common and popular 
application on personal computers. One reason for this is the 
variety of tasks that they can be used for. Another reason is that 
they are relatively easy to use. 

In this session you will: 

 gain an understanding of spreadsheets and how they 
work 

 gain an understanding of the size and capacity of a 
spreadsheet 

 gain an understanding of three functions of a 
spreadsheet - calculations, graphs, and lists 

 gain an understanding of what spreadsheets can be used 
for and what is inappropriate. 
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UNDERSTANDING HOW SPREADSHEETS WORK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Word processing packages are designed to 
process words – they let you write letters, 
compose faxes, prepare reports, write books, and 
much more. Spreadsheet packages on the other 

hand, are designed to process numbers. While 
word processing applications are perfect for 
creating documents, spreadsheets are ideal for 
budgets, statistics, sales analyses, and the like. 

What Is A Spreadsheet? 

According to the Oxford Dictionary of Computing a spreadsheet is… 

“A program that manipulates tables consisting of rows and columns of cells, and displays 
them on a screen; the cells contain numerical information and formulas, or text… The 
value in a numerical cell is either typed in or is calculated from a formula in the cell; this 
formula can involve other cells. Each time the value of a cell is changed by typing in a new 
value from the keyboard, the value of all other cells whose values depend on this one are 
recalculated.” 

The screen above shows a spreadsheet application being used to calculate weekly pay for four 
employees. Spreadsheet applications are laid out as tables comprising rows and columns – notice 
how the columns have alphabetical headings and the rows are numbered (down the side) numerically. 
The intersection of a column and a row is known as a cell. Your data, comprised of text (referred to as 
labels), numbers (referred to as values), or formulas is typed into these cells. 

In the example above, the gross pays, total, average, maximum, and minimum figures are formulas 
which are dependent upon what is typed into Hourly Rate and Hours. Each time a value in Hourly Rate 
or Hours is changed all of the formulas that are dependent on that value are recalculated – instantly. In 
the screen below the Hours worked by Margaret Adams have changed from 24 to 33, and the Hourly 
Rate for Grace Francis has increased from $12.50 to $13.75 – notice how the relevant Gross Pay 
information and statistics have changed… 
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Numerical Information: Hourly Rate and 
Hours worked are typed into the cells so 
that they can be used to calculate Gross 
Pay. 


Formulas: Use the information in Hourly 
Rate and Hours worked to calculate 
Gross Pay and other statistical 
information. 


Text: Text is typed into the cells and is 
normally used as labels. Here text is 
typed to identify the employees, the 
column headings and also the types of 
statistical calculations. 

 


Changes in the Hourly Rate and Hours 
cells… 


…cause the formulas in these cells to 
instantly recalculate and reflect any 
changes. 
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UNDERSTANDING SPREADSHEET CHARACTERISTICS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Spreadsheets actually became popular in the late 
1970s and are ideally suited to personal 
computers. They have evolved steadily over the 
years and now include features and facilities that 

allow them to be used for more tasks than they 
were originally designed for. Their theoretical 
capacity for data is simply mind blowing! 

History of Spreadsheets 

Spreadsheets were developed with a specific use in mind. One of the earliest spreadsheet programs was 
developed in the mid-70s by Dan Bricklin, an MBA student at Harvard Business School. 

Dan found that he had to create a number of complex business models that required tables of numbers that 
had to be constantly added and averaged. These numbers were written up on large sheets of paper with 
grand totals and averages at the bottom. He was required to enter new numbers and recalculate the bottom 
line to come up with a variety of business models. Dan got a bit tired of doing this on his calculator. So he 
developed an electronic version of a large sheet of paper that was ruled into columns and rows, and that 
could perform calculations. Spurred on by his friends he refined this product and marketed it as VisiCalc. 
Accountants and other people who had to prepare tables of numbers loved it. 

In the 1980s VisiCalc was overtaken by another product, Lotus 1-2-3. This product added more functionality 
to the spreadsheet concept, allowing the user to draw graphs based on the numbers and to perform some 
elementary sorting and querying of the data just like a database package. 

Since the advent of Windows 3.0 in June 1990, Microsoft Excel has become the predominant spreadsheet 
product – although IBM, who owns Lotus 1-2-3, might argue the toss on this one! 

The Anatomy of a Spreadsheet 

Spreadsheets, such as Microsoft Excel, are just like electronic sheets of paper that have been ruled up into 
tables comprising of columns and rows. In Microsoft Excel the screen is referred to as a worksheet and it 
is actually made up of 16,384 columns across the screen, and 1,048,576 rows down the screen. If you 
hold a ruler up to the screen each column measures about 2.1 cm in width and about 0.5 cm deep. 
Performing some basic maths, 16,384 columns and 1,048,576 rows would give you a piece of paper about 
344 metres wide and 524 metres long – this is one very big piece of paper! 

In Microsoft Excel when you save your work it is saved in a file known as a workbook. A workbook is made 
up of one or more worksheets – you can have thousands of worksheets in each workbook, although you 
usually start with three. Each worksheet is given a label such as Sheet1, Sheet2, etc. These sheet labels 
appear at the bottom of the screen. In reality, what you see on the screen at any point in time is just a very, 
very, very tiny part of your huge electronic piece of paper!  

When a row and a column intersect you have a cell. Each cell can hold up to 32,767 characters (each 
character roughly equivalent to a letter or number – for example, the name John occupies 4 characters of 
space, one for each letter). Given that there are 16,384 columns and 1,048,576 rows there are actually 
17,179,869,184 cells in a worksheet. If each of these holds 32,767 characters you’ll have a theoretical 
capacity in each worksheet of 562,932,773,552,128 characters… But all of this is theoretical and is limited 
to the actual memory (RAM) capacity of your computer. 

Columns: There are 
16,384 of these 

Rows: There are 
1,048,576 of these 

Worksheets: The number 
of these is limited only by 
your computer’s memory 
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UNDERSTANDING SPREADSHEET FUNCTIONALITY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Over the years the functionality of spreadsheets 
has increased. Today spreadsheets provide three 
main functions. Primarily they allow you to type 
numbers to perform calculations. They also allow 

you to display those numbers pictorially as graphs. 
Finally, spreadsheets allow you to enter data into 
lists and to perform rudimentary operations such as 
sorting, filtering, and summarising of those lists. 

Performing Calculations 

Spreadsheets are most commonly 
identified as applications that help you 
process numbers. Numbers are 
entered into cells and formulas that 
use these numbers are automatically 
and instantly recalculated. This is 
sometimes referred to as numeric 

modelling. 

Creating Graphs 

Graphs, or charts as they are known 
in Excel, allow you to pictorially view 
the data in a worksheet. Charts are 
created based on one or more series 
of numbers that are in the worksheet. 
These numbers may be ones that 
have been typed or ones that appear 
as the result of a calculation. Like 
formulas, charts are automatically 
updated when the data in the 
worksheet changes. 

Working With Lists 

A list is simply a collection of 
items organised into columns 
and rows – and since that is 
how a worksheet is organised 
it is only logical that list-type 
operations can be performed. 
These operations include the 
ability to filter (search and 
display) specific data, the 
ability to sort the data either 
numerically or alphabetically, 
and the ability to summarise 
the data such as displaying 
the total of a particular 
column. 
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THE APPROPRIATENESS OF SPREADSHEETS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Basically spreadsheets can be used for virtually 
any task that uses numbers and needs to be 
calculated. While they initially gained momentum 
in the accounting professions, spreadsheets are 

now used throughout the business community, in 
Government, manufacturing, science, and many 
other areas of industry.  

Where Spreadsheets Are Well Suited 

Spreadsheets are basically just like large electronic pieces of paper ruled up into columns and rows 
that allow you to crunch numbers. The piece of electronic paper that you work with, known as a 
worksheet, is huge. However, spreadsheets have one Achilles heel – all of the worksheet must be 
loaded (or at least pass through) the computer’s memory, known as RAM. There isn’t a computer on 
the market today that can handle an entire worksheet filled with data. So while big is theoretically 
probable, it is technically impossible, and worksheets need to be kept relatively small to perform 
efficiently. Given this limitation, there are still a gazillion uses in the modern world for spreadsheet 
applications such as Microsoft Excel. 

In Business and Government… 

Spreadsheets are used for a diverse range of purposes, including budgeting, analyses of sales and 
costs, monthly reporting of sales and costs, financial modelling, loan recalculation and amortisation, 
petty cash, bank and credit card reconciliations, producing simple lists, producing charts and graphs 
for business presentations, and more. 

In Industry… 

Spreadsheets are used in manufacturing for estimating things such as materials, costs, and the like, 
and for analyses of data captured by manufacturing or scientific equipment. Other uses of 
spreadsheets include price lists and statistical analyses for quality control. 

At Home… 

Yes, even at home spreadsheets can be quite useful for things such as tracking personal finances, 
credit card and bank reconciliations, hobby and small business bookkeeping, asset registers, and the 
like. The lists functionality is perfect for keeping small lists (of about several hundred lines) of things 
such as names and addresses, CD collections and wine collections. Spreadsheets can also be used 
for sporting clubs, hobby associations, and other groups or clubs where basic accounting and member 
records need to be kept.  

Where Spreadsheets Are Unsuited 

Most people fall in love with spreadsheets once they learn the basics – spreadsheets are probably the 
simplest of all of the personal computer applications to use. As a consequence some people tend to 
use spreadsheets for everything, including things that they are inappropriate for such as writing lengthy 
documents. 

As mentioned above the single greatest drawback with spreadsheets is that they promise so much in 
that they give the illusion that they can handle vast amounts of data. However, given that everything 
processed in a spreadsheet must pass through the computer’s memory, the true size of a worksheet is 
really much smaller than the 16,384 columns and 1,048,576 rows. In fact, the larger your worksheet 
grows, the less efficient it becomes.  

So there are definitely things that you should NOT do with a spreadsheet. 

First and foremost, you shouldn’t attempt to produce text-based documents such as a letter or a memo 
with a spreadsheet. It’s not designed for this – use a word processing package such as Microsoft Word 
for this type of task. 

Spreadsheets are great for producing and manipulating lists – providing they are kept small. However, 
some users create a list in a spreadsheet and then keep adding and adding new data until one day the 
whole thing just chokes up. As a rough rule of thumb lists of more than several hundred lines 
(sometimes known as records) are better placed into a database application such as Microsoft Access. 
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NOTES: 
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CHAPTER 2 GETTING TO KNOW MICROSOFT EXCEL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft Excel is a spreadsheet application that is usually part of 
a suite of Microsoft applications, known as Microsoft Office. 

You can use Excel for all sorts of tasks involving numbers such as 
budgeting, sales analysis, forecasting, charting and graphing and 
much more. Excel is a tool used to perform calculations with 
numbers so virtually any task that requires calculation and number 
crunching can be setup and performed in Excel. 

Before you leap into creating anything, it is worth taking some time 
to become familiar with the Excel environment and its features. 

In this session you will: 

 learn how to start Microsoft Excel 2010 

 gain an understanding of the Microsoft Excel 2010 
screen 

 gain an understanding of how Microsoft Excel 2010 
works 

 learn how to use the Ribbon 

 learn how to use the keytip badges on the Ribbon 

 learn how to minimise the Ribbon 

 gain an understanding of Backstage View in Microsoft 
Excel 

 learn how to access the Backstage View 

 learn how to use shortcut menus 

 gain an understanding of how dialog boxes work 

 learn how to launch a dialog box 

 gain an understanding of the Quick Access Toolbar 

 learn how to add commands to the Quick Access 
Toolbar 

 gain an understanding of the status bar 

 learn how to exit correctly and safely from Microsoft 
Excel 2010. 
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STARTING MICROSOFT EXCEL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 

Before you begin, ensure that 
your computer is switched on 
and that the Windows desktop is 
displayed on your screen… 


Click on the Windows 
Start button (it’s a round 
button with a Windows 
logo on it) at the bottom 
left-hand corner of the 
screen to display the 
menu 


Click on All Programs 


Click on Microsoft Office 


Click on Microsoft Excel 
2010 

After a few moments of 
huffing and puffing Excel 
will start with a blank 
“workbook” on the screen 
– the workbook appears 
like an electronic sheet of 
paper ruled into columns 
and rows. 

 

For Your Reference… 

To start Microsoft Excel: 

1. Click on the Windows Start button 

2. Click on All Programs 

3. Click on Microsoft Office 

4. Click on Microsoft Excel 2010 

Handy to Know… 

 If you have accessed Microsoft Excel several 
times it should appear in the first part of the 
Start menu – this means you won’t need to 
continue to the All Programs menu. 

 

To create a new spreadsheet, or edit an existing 
one, the first thing that you need to do is to start 
Microsoft Excel. As a standard software 
application, how Microsoft Excel is started is 

largely determined by Windows. For example, it 
can be started from the Windows Start menu, from 
a shortcut, or even by opening a workbook 
(project) that was created previously in Excel. 
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THE EXCEL 2010 SCREEN 
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The Microsoft Excel 2010 screen is made up of 
several key elements. Some of these, such as 
the Ribbon and the Backstage, are common to 
other Office 2010 applications so once you know 

how they work you won’t have to relearn them 
when you use other applications. The unique 
aspect of Excel is the worksheet where you enter 
and work with your data. 

 

The Ribbon is the tabbed band that appears across the top of the window. It is the command control 
centre of Excel 2010. You use the tabs on the Ribbon to access commands which have been 
categorised into groups. Commands can be buttons or sometimes include galleries of formatting 

options that you can select from. 


The File tab is used to access the Backstage view which contains file management functions such as 
saving, opening, closing, printing, sharing, etc. Excel Options are also available so that you can set your 
working preferences and options for Excel 2010. 


The Worksheet is like an electronic piece of paper ruled into columns and rows. The worksheet is where 
you type numbers, letters, and formulas to perform calculations. Notice that columns are headed using 
letters of the alphabet (A, B, C, etc) while rows are designated using numbers down the left side. 

 

The Active Cell is where text, numbers, and formulas will appear when you start typing. 


The Mouse Pointer is used, amongst other things, to select a cell and make it active. It may appear as a 
large cross, as in this example, as an I-bar, or any number of other forms, depending upon its function at 
that position on the screen. 

 

The Status Bar appears across the bottom of the window and displays useful information about what is 
happening in the worksheet. At present it shows Ready which means that Excel is ready to be used for 
your project. 


The View buttons and the Zoom Slider are used to change the view or to increase/decrease the zoom 
ratio for your worksheet. 


The Scroll bar indicates your current position in the worksheet and lets you move to other positions in 
the worksheet by clicking or dragging. The arrows can also be used to move through the worksheet. 
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HOW MICROSOFT EXCEL 2010 WORKS 
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For a novice user the Microsoft Excel 2010 
screen can seem intimidating. You’ll soon see 
that it is made up of only three key areas. The 
data you type is placed on a worksheet. The 

data within the worksheet can be manipulated and 
changed using commands on the Ribbon. The 
worksheet is part of a larger entity known as a 
workbook which is controlled on the Backstage. 

The Worksheet 

A worksheet appears as a number of 
rows and columns which form squares 
known as cells. Everything you type in 
Excel is entered into these cells. In the 
simple business plan shown here there 
are numbers and words entered into a 
worksheet. Formulas are also entered 
that automatically perform calculations. 
The worksheet is part of a larger entity 
known as a workbook – workbooks can 
be filed away for future use or for 
sharing and can also be printed. 

2 The Ribbon 

When you need to do something with the data on a worksheet, such as format it, colour it, analyse it, 
move it, copy it, and much more, you’ll find all of the relevant commands on the Ribbon. The Ribbon 
has commands organised thematically using a series of tabs across the top. 

Backstage 

When you want to do something with 
the data in your worksheet, such as 
save it so that you can access it 
again later, print it, share it with a 
colleague, send it to your boss, 
protect it from prying eyes, or 
whatever, you will need to access 
the Microsoft Office Backstage 
area of Microsoft Excel. The 
Backstage is accessed using the 
File tab on the Ribbon. Rather than 
offering you commands on a Ribbon, 
Backstage occupies the entire 
screen and has a series of options 
down the left side. Here the Print 
option is active, and that is why you 
can see a preview of the worksheet 
and a series of print-related options 
on the right side of the Backstage. 
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USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before trying this ensure that Microsoft 
Excel 2010 has started… 


Examine the groups on the 
Home tab 

These are the most commonly 
used commands, including copy 
and paste, font and number 
formatting, styles and editing... 


Click on the Insert tab 

The commands on this tab are 
used to create tables, 
illustrations, charts, headers and 
footers, text objects and 
symbols... 


Click on Shapes in the 
Illustrations group to display 
the Shapes gallery 

A huge range of shapes will 
appear which can be inserted 
into the worksheet… 


Click on some of the other tabs 
across the top of the Ribbon 
(Page Layout, Formulas, etc) 
and examine the commands on 
them 

Some of these open “dialog 
boxes”... 


On the View tab, click on Zoom 
in the Zoom group to display the 
Zoom dialog box 


Click on [Cancel] then click on 
the Home tab 

 

For Your Reference… 

To use the Ribbon: 

1. Click on a tab to display the commands 

2. Click on a button to activate a command, 
display a gallery, or display a dialog box 

Handy to Know… 

 Additional tabs known as Contextual tabs 
appear in specific circumstances. For 
example, if you insert a picture, the Picture 
Tools: Format tab will appear. This provides 
quick access to all of the tools you may need 
to modify and work with the picture. 

3 

2 

The Ribbon is the command centre for Microsoft 
Excel. It provides a series of commands 
organised into groups and placed on relevant 
tabs. Tabs are activated by clicking on their 

name to display the command groups. Commands 
are activated by clicking on a button, tool or gallery 
option. Everything you could possibly want to do in 
Excel will be found somewhere on this Ribbon. 

Dialog boxes like this one 
provide settings or options for 
you to choose from. For 
example in this one you can 
zoom the screen by varying 
percentages. We won’t 
actually do anything at this 
point. You’ll get plenty of 
opportunity for using dialog 
boxes at a later stage… 
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USING RIBBON KEY TIPS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before trying this ensure that 
Microsoft Excel 2010 has started… 


Press  to display the key tip 
badges for the tabs 


Press  to display the Page 

Layout tab and to see the key 
tip badges for these 
commands 


Press  to display the 

Margins options 

Here you could use the  or 

 keys to move through the 

options, or  to see Custom 

Margins… 


Press  twice to return to the 

Tab level of key tips 


Press  to access the 

Formulas tab 


Press  five times and 

notice that Logical is selected 


Press  to see a list of 

Logical functions, then press 
 several times to move 

down the menu 


Press  to abort the 

operation 

 

 

For Your Reference… 

To use KeyTip Badges to access commands: 

1. Press  to display the KeyTip Badges 

2. Press the letter key of the command or tab 
that you want to select 

Handy to Know… 

 You can still use the shortcut keys for menu 
commands that were available in previous 
versions of Office. For example,   +  

applies bold to selected text. 

1 

2 

The Ribbon is normally accessed with a mouse. 
However you can also use the keyboard to 
access Ribbon commands. When you press the 

  key on the keyboard alphabetical labels, 

known as key tip badges, appear on the Ribbon. 
Pressing a key on the keyboard will activate the 
corresponding command on the Ribbon just as if 
you’d clicked the command with the mouse. 
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